Avid Media Composer
Virtual Environment with VMware®
Best Practices Guide

Media Composer v8.8.5 and later
Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S. patents. Details are available at www.avid.com/patents.

This guide is protected by copyright. This guide is for your personal use and may not be reproduced or distributed, in whole or in part, without permission of Avid. Reasonable care has been taken in preparing this guide; however, it may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. disclaims liability for all losses incurred through the use of this document. Product specifications are subject to change without notice.

Copyright © 2017 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:

APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:

Copyright © 1988–1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:

This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:

Copyright (c) 1989 The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (C) 1989, 1991 by Jef Poskanzer.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.
## Contents

**Using This Guide** ......................................................... 5  
Symbols and Conventions ................................................ 5  
If You Need Help .......................................................... 6  
Avid Training Services ..................................................... 6  

**Chapter 1** Virtual Environment with VMware Best Practices .................. 7  
Overview ................................................................. 7  
Qualified VMware Versions ............................................... 9  
VMware Validation Environment Details ................................ 10  
Connecting External Peripherals ........................................ 12  
Media Composer VM Performance Characteristics .................. 15  
Client Requirements ...................................................... 18  
Managing and Monitoring Virtual Resources .......................... 18  
Benefits of Maintaining VMs on Shared Storage ...................... 20  
Centralized Hypervisor Management .................................... 21  

**Chapter 2** Creating Virtual Machines .................................. 22  
Uploading the Windows ISO to the Datastore ......................... 22  
Creating a New Virtual Machine ........................................ 23  

**Chapter 3** Installing Windows and Media Composer .................... 31  
Accessing the Virtual Machine ......................................... 31  
Configuring the Virtual Machine BIOS ................................ 33  
Installing Windows Operating System ................................ 34  
Installing VMware Tools .................................................. 35  
Installing and Configuring the PCoIP Agent .......................... 37  
Adding a vGPU to the Virtual Machine ................................ 39  
Installing Media Composer ................................................ 42  
Adding Avid Artist DNx I/O to the VM .................................. 43
Using This Guide

This guide describes the test environments used by Avid Technology to create and operate Avid Media Composer as a virtual machine using VMware® vSphere® 6. It provides details to help you select host servers and to optimally configure the virtual machines.

This guide is intended for system administrators, salespeople, and other personnel who plan to provision and/or deploy hardware and software for Avid Media Composer in a virtualized environment. All readers should have a basic understanding of VMware technology.

⚠️ The information contained in this document serves as a guideline for creating Media Composer VMs only. At this time, Avid Technology does not guarantee the number of streams/tracks, network bandwidth, or other performance factors based on the configurations described in this document.

This document is subject to change and is periodically updated. Before you begin an installation, check the following Avid Knowledge Base article for the latest version:


Revision History

<table>
<thead>
<tr>
<th>Date Revised</th>
<th>Changes Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>October, 2017</td>
<td>New features:</td>
</tr>
<tr>
<td></td>
<td>• Avid Artist Color, Artist Mix, and Artist Control</td>
</tr>
<tr>
<td></td>
<td>• Avid Artist</td>
</tr>
<tr>
<td></td>
<td>• Centralized hypervisor management through Leostream</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Centralized Hypervisor Management” on page 21.</td>
</tr>
<tr>
<td></td>
<td>Added support for VMware vSphere 6.5 Update 1 (6.5u1)</td>
</tr>
<tr>
<td></td>
<td>Added support for Avid Media Composer virtual machines on Windows 10 Pro</td>
</tr>
</tbody>
</table>

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

<table>
<thead>
<tr>
<th>Symbol or Convention</th>
<th>Meaning or Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>A note provides important related information, reminders, recommendations, and strong suggestions.</td>
</tr>
<tr>
<td>🚨</td>
<td>A caution means that a specific action you take could cause harm to your computer or cause you to lose data.</td>
</tr>
<tr>
<td>&gt;</td>
<td>This symbol indicates menu commands (and subcommands) in the order you select them. For example, File &gt; Import means to open the File menu and then select the Import command.</td>
</tr>
</tbody>
</table>
If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was published. You should always check online for the most up-to-date release notes or ReadMe because the online version is updated whenever new information becomes available. To view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read or join online message-board discussions.

Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and convenient. Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid continually updates course content and offers new training delivery methods that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, please visit www.avid.com/support and follow the Training links, or call Avid Sales at 800-949-AVID (800-949-2843).
Virtual Environment with VMware Best Practices

The following topics describe best practices and minimum requirements for an Avid Media Composer virtual environment:

- Overview
- Qualified VMware Versions
- VMware Validation Environment Details
- Connecting External Peripherals
- Media Composer VM Performance Characteristics
- Client Requirements
- Managing and Monitoring Virtual Resources
- Benefits of Maintaining VMs on Shared Storage
- Centralized Hypervisor Management

Overview

Virtualizing Avid Media Composer provides the following benefits:

- Deploy and operate multiple Media Composer clients on the same physical machine
- Consolidate hardware to get higher productivity from fewer physical servers
- Reduce power consumption and cooling requirements
- Simplify the process of managing IT operations
- Upgrade software in a production environment faster and with reduced risk

For an overview of virtualization, see the following link:


For detailed information about VMware and vSphere, see the following link:

https://www.vmware.com/products/vsphere/
# Definition of Terms

The following table defines some of the commonly used terms associated with virtualization:

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtualization</td>
<td>Refers to the act of creating a virtual (rather than actual) version of something, including (but not limited to) a virtual computer hardware platform, operating system (OS), storage device, or computer network resources.</td>
</tr>
<tr>
<td>VM</td>
<td>Virtual machine</td>
</tr>
<tr>
<td>vCPU</td>
<td>Virtual CPU</td>
</tr>
<tr>
<td>ESXi</td>
<td>The OS of a VMware host server. This can refer to either the free release, or any one of the licensed editions. The same installer is used for all (same installation instance can have any of the licenses applied to it).</td>
</tr>
<tr>
<td>VMware host</td>
<td>Physical server with ESXi installed on it. Utilized for physical resources such as CPU, RAM, network, SAN connections, or local datastores.</td>
</tr>
</tbody>
</table>
| vCenter server    | A server used to administer VMware host servers or vSphere clusters. The vCenter server can be one of the following:  
|                   | • A Windows server (physical or virtual)  
|                   | • A virtual appliance  
|                   | vCenter provides tools and a central interface for managing all connected VMware hosts and VMs, including the ability to migrate VM’s from one host to another using vMotion. vCenter also simplifies the process of updating your hosts using the VMware Update Manager component. If the VMware Update Manager is not used, administrators must update each host manually via the command line interface (CLI). |
| Virtual appliance | A pre-configured VM that’s available for importing into an existing vSphere environment. Often using a Linux OS.                          |
| vSphere           | Combination of ESXi host servers and a vCenter server configuration.                                                                         |
| vSphere client    | A Windows or Mac system capable of connecting to the vSphere server. The connection is established through either a locally installed client application (Windows only) or a web portal. |
| vMotion           | Also known as a migrate task, vMotion can be used to move a live VM from one host server, or one datastore, to another without any down time. Often coupled with shared storage. Storage vMotion can be within a single host server or SAN (or group of LUNs on a single SAN configuration/cluster). If an administrator needs to move a VM between host servers with only local datastores, the task is only available on a ‘cold’ (powered off) VM. |
| vSphere Fault Tolerance | vSphere Fault Tolerance provides continuous availability for virtual machines by creating and maintaining a Secondary VM that is identical to, and continuously available to replace, the Primary VM in the event of a fail-over situation. |
| vSphere HA        | A feature that enables a cluster with High Availability. If a host goes down, all virtual machines that were running on the host are promptly restarted on different hosts in the same cluster.  
|                   | When you enable the cluster for vSphere HA, you specify the number of hosts you want to be able to recover. If you specify the number of host failures allowed as 1, vSphere HA maintains enough capacity across the cluster to tolerate the failure of one host. All running virtual machines on that host can be restarted on remaining hosts. By default, you cannot turn on a virtual machine if doing so violates required fail over capacity. |
| MPIO              | Multi Path In/Out. A common configuration to improve performance with shared storage.                                                        |
Qualified VMware Versions

VMware vSphere 6.0 Update 3 (6u3) is the minimum version of software required to run Avid Media Composer in a virtual environment. This means that the vCenter server must be running version 6u3 (or later versions such as 6u3b). Any host server that is not running a Media Composer VM can remain at a previous vSphere/ESXi release and coexist within the configuration. For complete details regarding VMware version compatibility, see https://www.vmware.com/.

Avid has also tested VMware vSphere 6.5 Update 1 (6.5u1) and encourages users to update to this version of VMware whenever possible to take advantage of the latest fixes and features included in this release.

Whenever planning an upgrade to the VMware software, you should make sure to plan for the appropriate down-time. Upgrades often require one or more reboots of the VMware servers. Additionally, Avid recommends taking a snapshot of the vCenter Server before any update.

Avid recommends applying security patches to the VMware host servers on a quarterly basis (at minimum). If higher security risks are identified, shorter intervals of time are recommended.

If you encounter an issue in the vSphere or vCenter software that is addressed by a VMware update, Avid might require you to upgrade the VMware environment.

For those customers using VMware Horizon, Avid has completed testing against v7.1 and v7.2 of the Horizon software.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>IOPS</td>
<td>Input/Output Operations Per Second. A unit of measure for datastores (local or shared).</td>
</tr>
<tr>
<td>virtual core</td>
<td>Similar to the concept of physical processors cores and sockets, a virtual core is a subdivision of a virtual socket. For example, an Intel E5-2640 v3 Xeon processor has 8 cores per processor. A VM can be configured to have X virtual cores per virtual socket allocated to it. Such as 2 virtual sockets with 2 virtual cores each, giving the VM 4 vCPUs.</td>
</tr>
<tr>
<td>LUN</td>
<td>Logical unit number. A reference to a logical grouping of drives.</td>
</tr>
<tr>
<td>VMXNET3</td>
<td>VMXNET Generation 3. This is a virtual network adapter designed to deliver high performance in virtual machines (VMs) running on the VMware vSphere platform. VMXNET3 has the same features as the VMXNET2 adapter but with added functionality to minimize I/O virtualization overhead. To enable VMXNET3, VMs need to be on virtual hardware version 7 or later and may need VMware Tools installed, depending on which guest operating system (guest OS) is being used. VMXNET3 allows for 10 Gb (or higher) network speeds. If the VMware host’s network adapter is not capable of 10 Gb speeds, two VMs located on the same host can still take advantage of the higher bandwidth as the network traffic is not leaving the host server.</td>
</tr>
<tr>
<td>PCoIP</td>
<td>“PC over IP” is a protocol originally developed by Teradici to compress / decompress images and sound across local and wide area networks. This technology lowers the demand on the network while maintaining high quality images and sound.</td>
</tr>
<tr>
<td>Thin client</td>
<td>A low-resource PC that often includes a simplified operating system (e.g: Windows Embedded). The client connects to a server which is responsible for the majority of processing and data storage.</td>
</tr>
<tr>
<td>Zero client</td>
<td>A low-resource, small form factor, hardware device that typically includes monitor, keyboard, mouse, and network connections, but no operating system or storage. In the context of this document, the editor uses the device to connect to an Avid Media Composer running as a virtual machine.</td>
</tr>
</tbody>
</table>
VMware Validation Environment Details

This section lists the specifications for the host servers and SAN used for the Avid VMware validation environment. These specifications also serve as the minimum vSphere environment specifications for deploying a Media Composer as virtual machine. When purchasing a system, use the following specifications, their equivalent, or better. For optimal performance, Avid recommends that you meet or exceed these specifications.

Avid followed the VMware best practices for setting up the validation environment. For more information on VMware best practices, see: https://www.vmware.com/techpapers/2015/performance-best-practices-for-vmware-vsphere-60-10480.html.

VMware Validation Environment - Host Server Configuration

Avid used the Dell PowerEdge R730 as a validation system for the host server and the vSphere cluster. The following table lists the technical details of the server:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel Xeon E5-2695 v4</td>
</tr>
<tr>
<td>Form factor</td>
<td>A 2U form factor is required to accommodate the additional PCIe graphics cards.</td>
</tr>
<tr>
<td>Number of Processors</td>
<td>2</td>
</tr>
<tr>
<td>Processor Base Frequency</td>
<td>2.1GHz (max Turbo frequency of 3.3GHz)</td>
</tr>
<tr>
<td>Number of Cores</td>
<td>18/socket (36 Total)</td>
</tr>
<tr>
<td>RAM</td>
<td>256GB DDR4 RDIMM (8 x 32GB DIMMS)</td>
</tr>
<tr>
<td></td>
<td>The current generation of servers operate most efficiently when all memory channels are filled (all at one time). If you provision additional RAM with differently sized modules, add the largest sticks in the first memory channels. For example, if you have an existing server populated with 8x16GB sticks and you purchase a set of 32GB sticks, add the 32GB modules in the first set of memory channels and move the existing 16GB DIMMs into second set. Whenever provisioning RAM, do not allocate more than 75% of RAM installed in host server to the virtual machines.</td>
</tr>
<tr>
<td>Graphics</td>
<td>One NVIDIA Tesla M60 card with driver version 367.64</td>
</tr>
<tr>
<td>Drives</td>
<td>No internal storage. Drives configured as a three datastore cluster for virtual workstations (1.5TB each, 4.5TB total) on PS6210XS SAN</td>
</tr>
<tr>
<td>Operating System Drive</td>
<td>ESXi installed on dual 16GB SD card module</td>
</tr>
<tr>
<td>PCIe 3.0 Slots</td>
<td>4 used</td>
</tr>
<tr>
<td>Power Supply</td>
<td>Dual, Hot-plug, Redundant Power Supply (1+1), 1100W</td>
</tr>
<tr>
<td>Network connections</td>
<td>Be able to provide a 1 Gb connection per Media Composer VM. This can be a group of 1 Gb, or one or more 10 Gb connections, depending on your environment. If possible, Avid recommends using a group of 10Gb connections for maximum throughput. The following adapters are recommended for Avid ISIS or Avid NEXIS connectivity:</td>
</tr>
<tr>
<td></td>
<td>• Mellanox ConnectX3 Dual Port SFP+</td>
</tr>
<tr>
<td></td>
<td>• QLogic 57810 DP 10Gb SR/SFP+ Converged Network Adapter, with SR Optics</td>
</tr>
</tbody>
</table>
VMware Validation Environment Details

This section lists the specifications for each of the EqualLogic PS6210XS used during validation.

<table>
<thead>
<tr>
<th>Model</th>
<th>EqualLogic PS6210XS providing approximately 32k IOPS</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Controller</td>
<td>Dual controllers with a 16 GB non-volatile cache memory per controller</td>
</tr>
<tr>
<td>Network Interfaces</td>
<td>10 GbE</td>
</tr>
<tr>
<td>Management network</td>
<td>One (1) 100BASE-TX per controller</td>
</tr>
<tr>
<td>Interface ports</td>
<td>Two (2) 10GBASE-T with RJ45 or two (2) 10 Gb SFP+ for fibre or twin-ax copper cabling per controller</td>
</tr>
<tr>
<td>Controller configured</td>
<td>active/standby</td>
</tr>
<tr>
<td></td>
<td>One controller is active, the second is standby. Ports on the active controller are fully active while connections are good. If one port on the active controller loses its connection, its mirror on the standby controller becomes live. Maximum configured transfer rate is 20 Gbps from SAN.</td>
</tr>
<tr>
<td>Drives</td>
<td>7 SSD drives and 14 10k spindle drives in an accelerated RAID 6 array</td>
</tr>
</tbody>
</table>

For details on the EqualLogic PS6210X, see the following link:

PCoIP Infrastructure

The connection between the zero client device and the virtual machine is made possible through an agent running on the virtual machine. You must obtain and configure one of the following solutions before creating any Media Composer virtual machines:

- **Teradici Cloud Access Software**
  
  The Teradici Cloud Access Software Graphics Edition consists of software connection agent that is installed as a background application in a Windows 10 VM and provides PCoIP connectivity to remote clients. The software and licenses can be obtained directly from Teradici.

  For more information, see http://www.teradici.com/products/cloud-access/cloud-access-software.

- **VMware Horizon**
  
  Horizon is an add-on component for VMware vCenter that employs an implementation of the Teradici PCoIP protocol.

  For more information, see http://www.vmware.com/products/horizon.html.
Installing the Graphics Card Software

Prior to creating any Avid Media Composer virtual machines, make sure that the required software to support the NVIDIA Tesla M60 adapter has been installed on the VMware host.

When you purchase the graphics adapter, NVIDIA generates a welcome e-mail which includes one or more Product Activation Keys (PAKs). You must use the information in the e-mail to create an NVIDIA user account and register your product with the NVIDIA Licensing Portal. This registration process provides access to the drivers for both the VMware host and the Windows-based Media Composer virtual machine.

For more information on the registration and software download process, search the NVIDIA Knowledge Base for the NVIDIA GRID™ ENTERPRISE SOFTWARE Quick Start Guide at:

http://nvidia.custhelp.com/app/home/

Connecting External Peripherals

Avid supports connecting external peripherals that are part of the Avid Artist series to the Media Composer virtual machine. In some cases, hardware is added to the VMware host and the peripheral is shared as a “pass through” device. In other cases, the virtual machine connects directly to the device through the network.

For more information, see the following sections:

- Connecting to Avid Artist Control, Artist Mix, or Artist Color
- Connecting to an Avid Artist | DNxIO or Avid Artist | DNxIQ

Connecting to Avid Artist Control, Artist Mix, or Artist Color

Artist Control, Artist Mix, and Artist Color are part of the Artist Series family of media controllers. They use a 100 Mb/s Ethernet EUCON™ connection to control audio and video applications running on a virtual machine. EUCON is a high-speed communication protocol and enables control of virtually every application feature.

As these devices connect through a network interface, no additional configuration on the VMware host server is required. Simply connect the devices to your network through a qualified switch and follow the instructions in the Avid product documentation to connect the device to the Media Composer virtual machine.

EuControl v3.6.0 was used when testing Artist Control, Artist Mix, and Artist Color with a virtualized Media Composer editor.

As these are network connected devices, they are subject to network latency which can impact the user experience. However, Avid did not capture any noticeable difference in the latency between hardware-based workstations and virtual machines during the testing and validation process.

For more information on Avid Artist Color, Artist Mix, or Artist Control, see the following links:

Connecting to an Avid Artist | DNxIO or Avid Artist | DNxIQ

Avid Artist I/O device offer a wide range of analog and digital I/O to plug into today’s diverse media productions. Through these devices, you can connect all of your gear—from 4K cameras, video decks, and UHD devices, to HDR and audio monitors, mics, and switchers.

The connection to Avid Artist DNxIO and DNxIQ hardware is made possible through a specialized high speed data cable and a PCIe interface card that you install in your VMware host. Avid supports adding one or more DNxIO, DNxIQ, or a mix of these devices in the same server. The number of peripherals is only limited by the number of PCIe slots in the host server.

For more information on Avid Artist DNxIO and Avid Artist DNxIQ, see the following links:


To connect and configure the Artist DNxIO or DNxIQ hardware:

1. Power-off the VMware host and disconnect the power cable from the server.
2. Add the PCIe expansion card to the server and connect the DNxIO hardware. Do not power the server back on until the data and power cables are connected to the DNx hardware. The data cable should not be connected or disconnected while the server is powered-on.
3. Reconnect the power cable to the VMware host and power-on the server.
4. Open the VMware XSI host web interface, and select Host > Manage.
5. Select Hardware > PCI Devices from the Settings menu.

The following illustration shows the PCI Devices menu with an Avid DNx device already added to the configuration.

6. Click the pencil icon in the pane on the right to add a PCI device to the system configuration. A list of available PCI devices appears. The Avid DNx hardware is listed as a Blackmagic Design - Multimedia device.
7. Click the box to the left of the Blackmagic Design device to add the Avid DNx hardware to the system.

8. Click the OK button to confirm the selection.

9. Finally, you must reboot the VMware host server.

10. At this point, the installation and configuration of the Avid Artist hardware in the server is complete. Later in this document, after you complete the installation of Media Composer on the virtual machine, you must complete the process for “Adding Avid Artist DNx I/O to the VM” on page 43.

11. (optional) Although you can add video and/or audio cables to the DNxIO or DNxIQ at any time, you might want to take the opportunity to connect the cabling now. Avid recommends running an SDI cable from the device to a monitor in the office or workspace where the zero client device is located.

For more information on cabling the hardware, see the Avid Artist DNxIO and Avid Artist DNxIQ documentation.
Media Composer VM Performance Characteristics

This section provides information on creating Avid Media Composer virtual machines.

Allocating vCPUs and RAM to Media Composer VMs

The amount of RAM and number of vCPUs that are assigned to a Media Composer VM vary depending on the editor’s intended workflow. Broadcast workflows are often based on shorter, less complex sequences with fewer tracks and effects. Sequences created in post-production workflows are often more complex which might require additional put more load on the host system. In addition to sequence complexity, the video resolution of the media assets plays a role in determining the resources allocated to the VM. In these situations, a VM with more vCPUs and RAM can be beneficial.

The following table provide guidelines for allocating vCPUs and RAM to a Media Composer VM. The table also include data on the number of video streams tested by Avid. In addition to stream counts, each column shows the peak CPU usage of the VM for each resolution.

All values in the tables below are based on the Avid VMware validation environment. For details, see VMware Validation Environment Details.

<table>
<thead>
<tr>
<th>vCPU RAM vGPU</th>
<th>8 vCPU 16GB RAM GRID M60 - 4Q</th>
<th>16 vCPU 32GB RAM GRID M60 - 4Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNxHR LB (Low Bandwidth) in Ultra-HD 23.98</td>
<td>3 streams (full quality mode) 80% VM CPU</td>
<td>7 streams (full quality mode) 80% VM CPU</td>
</tr>
<tr>
<td>HD 1080p 23.98</td>
<td>10 streams (full quality mode) 88% VM CPU</td>
<td>12 streams (full quality mode) 50% VM CPU</td>
</tr>
</tbody>
</table>


Limitations and Notes

Review the following notes when running Media Composer in a virtual environment:

- vSphere fault tolerance is not supported.
- All virtualization testing has been completed using Avid Media Composer v8.8.5.
- Avid Media Composer has been tested in virtual machines using Microsoft Windows 10 Pro (64bit) and Windows 10 Enterprise (64bit).
  - If you are deploying Media Composer virtual machines from an automated pool based on a virtual machine template file, you are required to use Windows 10 Enterprise.
  - If you are creating a virtual machine manually or you are employing manual desktop pools, you can install Windows 10 Enterprise or Windows 10 Pro on the virtual machine.

For more information on configuring automated or manual pools, see the VMWare Horizon documentation.
While the Windows operating system on the virtual machine is capable of connecting to a number of network attached storage solutions, it is important to note that the Media Composer software will only recognize Avid ISIS or Avid NEXIS shared storage. Any non-Avid network attached storage will not be recognized by the Media Composer software.

Avid ISIS v4.7.5 or Avid NEXIS v7.6.0 are the required minimum back-end (server) versions for virtualized Media Composer systems. Regardless of the back-end system, you must use version 7.6.0 or later of the Avid NEXIS Client on the virtual machine.

The ability to work collaboratively using shared bins on network attached storage is limited to bins stored on Avid shared storage. If a user attempts to access a bin that is already open on another instance of Media Composer, the bin appears locked in Media Composer and it cannot be accessed.

The following capabilities / functions were tested and are currently not recommended for the reason provided in each case. Avid continues to investigate these issues to improve the user experience.

- Single and dual monitor configurations have been tested with the zero client. Do not connect more than two monitors, and do not exceed a resolution of 1920x1200 on any monitor. Higher resolution monitors place increased demand on the PCoIP protocol, resulting in dropped video frames during playback.
- Avid does not recommend playback of media above a frame rate of 30-fps. Formats above 30fps might drop video frames during playback.
- Using the Full Screen playback mode might result in dropped frames during playback. There is an additional issue with Full Screen playback using the Horizon PCoIP agent where the network is reanalyzed each time you hit play. This causes a video stutter during the first 3-4 seconds of playback.
- Media Composer GPU effects processing is disabled by default in Media Composer v8.8.5 when installed on a virtual machine. Avid has observed issues with the GPU resource assignment in a multi-client VM environment that impacts overall performance. For this reason, Avid recommends keeping the GPU effects processing disabled for all Media Composer virtual machines.
- As you increase the number of Media Composer virtual machines running on a single host server, you also increase the possibility of dropped frames during playback.
- The RED AMA Plug-in is limited to Best Performance mode (yellow / yellow). Users might experience dropped frames on playback in other modes.
- Remote access of Media Composer virtual machines has been tested on a low latency, high bandwidth, local area network. The response time for interactive operations might increase as the latency increases. Higher latency networks and periods of high network traffic on low latency networks might result in dropped frames during playback.

Accessing the virtual machine from a wide-area network or through a VPN solution might introduce additional latency which can negatively affect the user experience.

Avid tested connecting to and operating Media Composer virtual machines using the Teradici and Horizon View software clients. While the system was functional, Avid observed that these connection methods dropped two or more frames per second during playback in some cases. This was the case when using thin clients (worst case), laptops, and workstations as a client.
Configuring Virtual Drives on Media Composer VMs

Each Media Composer VM only requires a single volume and partition for the operating system and applications. Avid recommends allocating at least 200GB of hard drive space for each Media Composer VM.

For maximum performance, Avid highly recommends using Thick Provisioned, Eager Zero for all Avid Media Composer virtual drives. This applies to virtual volumes created on local and shared storage arrays.

⚠️ Avid has only tested Avid NEXIS and Avid ISIS for storing and accessing media assets. Avid does not recommend using the VMware host local drives or SAN storage for media assets.

Host Server and SAN Specifications

For host server recommendations, see “VMware Validation Environment - Host Server Configuration” on page 10. If you are not using a SAN and are using local storage, Avid recommends the following:

- For internal drives on a single standalone host: 8 15K RPM (or higher) SAS drives configured as RAID 10 using a Hardware RAID controller with NVRAM of 1 GB or greater. For example, Dell PERC H730.

For SAN recommendations, see “VMware Validation Environment - SAN Configuration” on page 11. As with the host server specifications, Avid recommends an equivalent or better system, or one that can provide the performance that the Avid VMs require.

Common VM Settings

The following guidelines are common across all configurations:

- To protect your most sensitive virtual machines, deploy firewalls in virtual machines that route between virtual networks with uplinks to physical networks and pure virtual networks with no uplinks.
- Make sure that the VMware tools are installed and up to date.
- VMXNET 3 is the required network adapter for all virtual machines.
Client Requirements

Avid requires using a zero client device to connect to, and operate virtualized Media Composer systems. The following zero client devices have been tested by Avid:

- HP t310 Zero Client (Model Number: C3G80AT#ABA)
- Dell Wyse 5030 zero client

Each of the devices listed above include firmware that supports the PCoIP protocol. To enable the image and sound compression between the zero client and the virtual machine, you must also install a PCoIP agent on the virtual machine.

For more information, see “Configuring the Teradici Agent” on page 37.

Limitations and Notes for the Zero Client Device:

- Do not connect any USB devices to the zero client, other than a standard mouse and keyboard.
  PCoIP protocol caps USB on the client at 4 to 6 MBps transfer speed so as not to impact the bandwidth associated with the client responsiveness.
- When monitoring audio tracks, Media Composer detects the 1/8-inch mini jack on the zero client and automatically defaults to a stereo mix.
- Audio playback through the zero client might result in an A/V sync delay of up to 100ms (3 or 4 frames late depending on the frame rate). This delay is in the implementation of the PCoIP protocol.

Media Composer v8.9 introduces a Desktop Play Delay setting which can offset this limitation and provide better a/v sync to the zero client. For more information, see “Adjusting the Play Delay Offset” in the Avid Media Composer Editing Guide.

- Zero clients must be connected through a 1GbE network connection at minimum to support the required bandwidth.

Managing and Monitoring Virtual Resources

All virtual machines contain the following basic components:

- An OS on a virtual disk
- Virtual memory
- vCPUs
- A virtual network adapter

As long as the host resources are not oversubscribed, multiple VMs can run on the same host server. Host hardware and VM resource requirements can vary greatly, so the number of simultaneous virtual machines can also vary. System administrators must monitor resource usage to determine if the host can support additional VMs.
In the Avid validation scenario, the SAN contains the physical drives that are presented as multiple LUNs (logical unit numbers). vCenter takes the LUNs and uses them as datastores for the VMs. A resource load-balancing utility called Distributed Resource Scheduler (DRS) is used to balance the load against the datastores.

Physical servers often benefit from more CPU resources than are needed without showing any negative effects. However, this is not the case for VMs. There are many cases where allocating more vCPUs actually results in performance degradation, especially if the applications on the VM are not multi-threaded. When creating virtual machines, best practices suggest allocating the minimum amount of resources to the VM and increasing the resources as needed. This means that you generally want to allocate fewer vCPUs to the VM than you might want to (initially).

**Best Practices for Working with Snapshots**

VMware Snapshots are not backups. A snapshot file is only a change log of the original virtual disk. Do not rely on it as a direct backup process. The virtual machine is running on the most current snapshot, not the original virtual machine disk (VMDK) files.

After creating a snapshot, the VM must read all information from the original image, plus the information in the change log. This inherently introduces performance degradation. Performance is further impacted if additional snapshots are created of the same VM. For this reason, it is best to avoid using snapshots with Avid virtual machines.

For additional information on working with Snapshots, see “Best Practices for virtual machines snapshots in the VMware Environment” on the VMware Knowledge Base:

[http://kb.vmware.com/selfservice/microsites/microsite.do](http://kb.vmware.com/selfservice/microsites/microsite.do)

Search for article ID 1025279.

**VMware Networking Best Practices**

For an overview of networking in a VMware environment, see the *vSphere Networking* guide at the following location:


**Monitoring VM Resources**

As part of Avid’s best practices for running Media Composer on VMs, enable the following Alarm Definitions from within vCenter server:

- Virtual machine CPU usage
- Virtual machine memory usage
- Host CPU usage
- Host memory usage

The trigger parameters should be left at the default settings. Enable email notification and provide a monitored email address for these alarms.
Benefits of Maintaining VMs on Shared Storage

When you design your virtual environment you must decide whether you will store your VM images on shared storage or on the internal drives of the individual host servers. The shared storage option is preferred for multiple reasons. This section describes some of the benefits of using shared storage.

*Shared storage in this context refers to an external SAN array and not Avid shared storage or any storage used to host media assets for editing or playback.*

**VMs and vCenter Residing on Shared Storage**

This method has the following benefits:

- All files that are used to build the VM are on the SAN. vCenter manages how the VMs use the host servers.
- vCenter can automatically load balance the servers or you can use the vCenter application to manually load balance the system. Options are fully automated, partially automated, or manual.
- If a host server goes down, vCenter can be configured to automatically move the associated VMs to another host server. This includes the vCenter VM.
- Host servers do not need to contain hard drives. ESXi can be installed on flash media.

**VMs Residing on one or two Host Servers with Internal Storage**

This method has the following drawbacks:

- You store the VMs on the individual host servers. Relies on RAID card configuration options selected for performance.
- You must manually balance the VMs between the host servers. Moving a VM from one server to another requires that you shut down the VM and manually migrate the VM to the other host server.
- If a host server goes down, you lose access to the VMs that were running on that host until the host is restored.

The primary reason why one might prefer to have local, internal storage over a SAN array could be the cost of the array. However, once you eliminate the cost of RAID controllers and local enterprise-class drives, the cost delta between local and shared storage narrows significantly. This becomes especially true once you move beyond a single VMware host server.
Centralized Hypervisor Management

For sites that employ multiple hypervisor solutions (such as VMware, Microsoft Hyper-V, or other) and need a way to simplify the management of these systems, Avid has qualified Leostream Connection Broker v8.2 with Avid virtual machines. Leostream is a vendor agnostic and protocol agnostic management tool that provides user access to virtual workstation instances. When deployed, a user can make a connection to the Leostream Connection Broker to log into a VM using either a zero client device or a software client. Administrators also have the ability to assign specific virtual machines to specific users.

To determine if Leostream is the right solution for your environment, consider the following use cases. Leostream allows you to:

• Create pools of available VM resources
• Create scenarios for VM user log out behavior
• Manage current state of VMs and user access
• Maintain user access logs and monitor which VM’s are used by which users
• Maintain usage statistics of pools
• Provision new virtual machine pools based on VMware templates or linked clones from snapshots
• Manage user roles and session control levels

If Leostream is a good fit for your organization, the following sections detail the components required for a VMware only environment and a mixed technology environment.

Leostream Connection Broker v8.2 does not support PCI-E device pass-through. This means that Avid DNx I/O devices cannot be added to Media Composer virtual machines using this version of Leostream software.

Components required for VMware only environment:

• VMware Horizon Connection Manager
• VMware Horizon Composer
• VMware Horizon Agent
• Zero Client or VMware Horizon Client (Software)

Components required for VMware VMs with Teradici PColP and the Leostream Broker:

• Leostream Connection Broker
• Leostream Agent (provides system status and power state management to Administrators)
• Teradici Connection Manager/Security Gateway
• Teradici License Server
• Teradici PColP Graphics Agent
• Zero Client or Teradici PColP Software Client

For more information on Leostream, visit their website at: https://www.leostream.com
Creating Virtual Machines

The process of creating a new Virtual Machine can be completed through either the vSphere “web client” or the “thick client”.

- Web client: Available to licensed copies of vSphere only, the web-based client offers much of the same functionality (and in some cases more functionality) as the thick client, but can be accessed through a web portal.

  The web client can be accessed by opening a web browser and navigating to: https://<vSphere server IP address or hostname>/vsphere-client.

- Thick client: This is a vSphere application that is installed on a Windows system.

  The thick client can be installed on your local system by opening a web browser and navigating to the IP address or hostname of the VMware host server. The server homepage includes a link to download the client software.

Both methods offer similar functionality and either can be used to create Avid virtual machines. This chapter describes how to create a virtual machine with the VMware Web Client.

While not yet supported by Avid, VMware v6.5 eliminates the use of the thick client. For this reason, users are encouraged to create VMs using the web client.

Uploading the Windows ISO to the Datastore

A Microsoft Windows 10 Enterprise ISO image is used to install the operating system on the Media Composer VM. For information on downloading a copy of the Windows image, see the Microsoft website at: https://www.microsoft.com/en-us/software-download/windows10

After the ISO has been downloaded or created, you must copy the ISO to the VMware Datastore. Review the following steps to copy the image file to the Datastore.

To upload the ISO to the datastore:

1. Open a web browser and log into the vSphere Web Client.

   The web client can be accessed by navigating to: https://<vSphere server IP address or hostname>/vsphere-client.

2. After you have logged in, click the Storage option from the Home menu on the left.
3. Click the Manage tab in the pane on the right and then select the Files option as shown in the following illustration:

![Datastore pane with Files option highlighted]

4. The pane on the left-side of the window shows the available Datastores. Click on one of the Datastores to select a location to upload the ISO file.

5. (optional) For organizational purposes, you might want to create a folder on the Datastore to hold the ISO file. If desired, click the folder button in the upper-right corner to create a new folder.

6. Click on a folder in the Datastore where you want the ISO file to reside.
   *If you do not select a folder, the file will be uploaded to the root directory of the Datastore. You can move the file to a folder after the upload is complete, but this process requires additional steps.*

7. Click the “Upload a file to the Datastore” button in the upper-right corner of the interface.
   *If this is the first time that you are using the web client to upload files to the Datastore, you are prompted to download the “Client Integration Plug-in”. This plug-in must be installed on your local machine to be able to complete the upload process. Once the plug-in has been installed, close and relaunch your web browser. If you have already installed the “Client Integration Plug-in”, you are presented with a Browse window.*


9. Select the file and click Open.

   The upload process begins. You can view the progress of the upload in the status pane at the bottom of the page.

10. Once the upload has completed, proceed to “Creating a New Virtual Machine” on page 23.

---

**Creating a New Virtual Machine**

The VMware web client allows administrators to assign different levels of user access to various aspects of the VM creation process. If you do not have access to create a VM (the option is grayed-out) or if you are unable to assign certain features within the VM (such as assigning a network adapter), see your vCenter administrator to request access to these features.

**To create a new Media Composer VM:**

1. Open a web browser and log into the vSphere Web Client.
   *The web client can be accessed by navigating to: https://<vSphere server IP address or hostname>/vsphere-client.*

2. Select the “Hosts and Clusters” option on the left side of the interface.

3. Click the arrows on the left to expand the tree and explore your vSphere environment.
4. Once you have selected a location for your new VM, right click on that location in the tree and select New Virtual Machine > New Virtual Machine, as shown in the following illustration:

![Create New Virtual Machine window](image1.png)

The Create New Virtual Machine window opens.

5. Select the “Create a new virtual machine” option and click Next at the bottom of the window.

6. The “Select a name and folder” pane opens:
a. Assign a logical name to the VM that follows your organization’s standard practices. This name only appears in the VMware interface and has no direct relation to the network host name.

b. If applicable, select a location in the Inventory for the VM. If you have a standalone VMware host, this option is not available

c. Click Next.

7. Select a compute resource that the VM will reside under. This can be either a host, cluster, or resource pool. Then click the ‘Next’ button.

8. The “Select storage” pane opens:

   a. VM Storage Policy: If your vSphere Administrator has created Storage Policies, apply the appropriate policy to this VM. If no policies have been created, this menu will not be active.

   b. Select a datastore location where the VM will reside.

      Depending on how your datastore is configured, you could have multiple options such as a storage cluster composed of multiple datastores presented from a SAN, or a single datastore that’s either on a SAN or local to the host.
If you have different tiers (or performance levels) of datastores, be sure to select the appropriate option for your configuration. Storage tier examples could include a set of large, but slower spinning disks or a set of fast but smaller solid state devices. Depending upon your configuration, VMs can be migrated to a different datastore later with Storage vMotion, a licensed option included in vSphere Standard Edition and higher.

c. Click Next.

9. In the “Select compatibility” pane, select a version of ESXi that you want your VM to be compatible with and click Next.

The “Compatible with” menu offers multiple selections with the highest option matching the software version of the ESXi host server.

For example, if the menu lists ESXi 6.0 and later, it indicates that the ESXi host server is running v6.0.

10. The “Select a guest OS” pane opens.
   a. Select Windows in the “Guest OS Family” menu.
   b. Select Microsoft Windows 10 (64-bit) in the “Guest OS Version” menu.
   c. Click Next.

11. The “Customize hardware” pane opens (default options shown):

The Customize hardware pane combines multiple menus (CPU, Memory, etc) and tabs (Virtual Hardware, VM Options, SDRS Rules) into a single window.

Click the arrow to the left of the CPU menu to reveal additional configuration options.
12. The CPU options are revealed:

Select the following options in the CPU menu:

a. Select the number of virtual sockets and cores per socket for the VM. Review the information in “Allocating vCPUs and RAM to Media Composer VMs” on page 15 as a guideline to determine the appropriate number of sockets and cores for your VM.

The standard configuration and recommendation is to allocate two sockets with 4 or 8 cores per socket.

b. Click the arrow to the left of the CPU menu to hide the options.

Notice that when a menu item is altered, the color of the menu option changes from blue-gray to yellow and an asterisk (*) appears to the left of the menu option.

13. Click the arrow to the left of the Memory menu to reveal additional configuration options.

Select the following options in the Memory menu:

a. Configure the amount of RAM to allocate to your VM.

Review the information in “Allocating vCPUs and RAM to Media Composer VMs” on page 15 as a guideline to determine the appropriate amount of RAM to allocate to your VM.

The MB / GB menu defaults to MB (megabyte). Make sure to adjust this to GB (gigabyte).
b. Enable the check box to “Reserve all guest memory (All locked)”. This option is required to add the graphics adapter later in the process.

c. (Optional) Enable the “Memory Hot Plug” check box. This option allows you to increase the amount of RAM assigned to the VM while it is in use.

d. Click the arrow to the left of the Memory menu to hide the options.

14. Click the arrow to the left of the “New Hard Disk” menu to reveal additional configuration options.

Select the following options in the “New Hard Disk” menu to configure the disk which hosts the operating system and applications:

a. Select a capacity for the volume.
   A basic installation of Windows 10 Enterprise consumes approximately 16GB of disk space. Avid Media Composer and related applications use another 5GB. Avid recommends configuring a disk of at least 200 GB in size to allow for expansion and additional applications.

b. Select a Disk Provisioning method.
   Avid recommends selecting “Thick Provision Eager Zeroed” for all disks.

c. Set the Location to: Store with the virtual machine

d. Click the arrow to the left of the “New Hard Disk” menu to hide the options.

15. Click the arrow to the left of the “New SCSI controller” menu to reveal additional configuration options.

Select the following options in the “New SCSI controller” menu:

a. Leave the SCSI Bus Sharing menu at the default of None.

b. Set the Change Type option to “LSI Logic SAS.”

c. Click the arrow to the left of the “New SCSI controller” menu to hide the options.
16. Click the arrow to the left of the “New Network” menu to reveal additional configuration options.

When using VMware vSphere 6, four network adapters are available in this menu: E1000 / E1000E, VMXNET 3, and SR-IOV passthrough.

- The E1000 adapter emulates a 1 Gb Intel 82545EM card. Emulating common hardware enables the BIOS and most operating systems automatically recognize the card, update drivers and enable network boot. The drawback to the E1000 is that the VM must work harder to emulate the exact specifications of the hardware. Every packet that is processed through this adapter must be “translated” which results in a slight performance hit.

- The VMXNET 3 adapter is native to VMware. That means that many operating systems see the adapter as an unknown device during OS installation. The benefit of the VMXNET 3 adapter is that it is optimized for use with VMware and no packet “translation” is required. Additionally, this is adapter is capable of reaching speeds of 10 Gb and higher. This is the preferred adapter for all Avid virtual machines.

VMware Tools is required to fully enable the VMXNET 3 adapter. The process to install this software is covered later in this document.

- The SR-IOV passthrough option allows any physical network adapter in the VMware host server that supports Single Root I/O Virtualization (SR-IOV) to be presented directly to the virtual machine.

Select the following options in the “New Network” menu:

a. Select a Port Group from the Network menu.

   If the Port Group you need to assign is unavailable, your vSphere user account may not have permissions to this network. See your vCenter administrator for access.

b. Enable the check box to “Connect at Power On.”

c. Set the Adapter Type menu to VMXNET 3.

d. Click the arrow to the left of the “New Network” menu to hide the options.
17. Click the arrow to the left of the “New CD/DVD Drive” menu to reveal additional configuration options.

![New CD/DVD Drive Configuration Menu](image)

Select the following options in the “New CD/DVD Drive” menu:

a. In the first menu, select “Datastore ISO File” to associate the Windows ISO file with the virtual optical drive.

b. In the Select File window, browse to the location of the Windows ISO, select it and click OK. This will populate the CD/DVD Media field.

c. Select the check box to “Connect At Power On.”

If this check box is not available (grayed-out), complete the remainder of this process, then right-click on the VM and edit the settings to enable this selection.

d. Click the arrow to the left of the “New CD/DVD Drive” menu to hide the options.

18. Remove the “New Floppy drive” by placing your cursor over the menu item. An “X” will appear on the right of the line item.

![New Floppy drive Configuration Menu](image)

Click the “X” to remove the floppy drive.

19. Click the arrow to the left of the “Video card” menu to reveal additional configuration options

   a. Adjust the “Total video memory” to 16 MB.

   b. Click the arrow to the left of the “Video card” menu to hide the options.

20. Instruct the virtual hardware to enter the BIOS on the first boot of the virtual machine.

   a. Click the VM Options tab at the top of the window.

   b. Click the arrow to the left of the “Boot Options” menu to reveal additional configuration options.

   c. Enable the check box to “Force BIOS setup.”

21. Configuration of the virtual hardware is complete. Click the Next button.

22. The final “Ready to complete” pane shows all the options you have configured for this virtual machine. Review the information to verify that all settings are correct.

23. Click Finish to complete the VM creation.

The virtual machine hardware is now ready to accept an operating system, proceed to “Installing Windows Operating System” on page 34 to continue the installation process.
Installing Windows and Media Composer

At this time, the virtual machine only represents virtual hardware. As with any installation, software must be added to create a fully functional system. In this section you will install and configure the Microsoft Windows operating system, supporting software, and Avid Media Composer.

This process consists of the following steps:

- Accessing the Virtual Machine
- Configuring the Virtual Machine BIOS
- Installing Windows Operating System
- Installing VMware Tools
- Installing and Configuring the PCoIP Agent
- Adding a vGPU to the Virtual Machine
- Installing Media Composer
- Adding Avid Artist DNx I/O to the VM

Accessing the Virtual Machine

Prior to adjusting the BIOS or installing the operating system, you must power on and connect to the virtual machine.

To access the virtual machine:

1. Open a web browser and log into the vSphere Web Client.
   The web client can be accessed by navigating to: https://<vSphere server IP address or hostname>/vsphere-client.
2. Select the “Hosts and Clusters” option on the left side of the interface and navigate to the location of your virtual machine in the tree.
3. Prior to powering on the virtual machine, verify that the “Connect at Power On” option is enabled in the virtual network adapter settings.
   Depending on how the virtual machine was originally created, it is possible that this option is currently not enabled.
   a. Right-click on the virtual machine in the Hosts and Clusters pane and select Edit Settings.
b. Click the arrow to the left of the “Network adapter 1” menu to reveal additional configuration options:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Configuration Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Connect At Power On</td>
</tr>
<tr>
<td>Adapter Type</td>
<td>VMXNET 3</td>
</tr>
<tr>
<td>DirectPath I/O</td>
<td>Enable</td>
</tr>
<tr>
<td>MAC Address</td>
<td>00:50:55:03:50:65</td>
</tr>
</tbody>
</table>


5. You must now open a console session to the virtual machine. This can be accomplished in one of the following two ways:

- **VMware Remote Console (VMRC) (recommended)** — This option is available by selecting the Summary tab in the right pane and selecting “Launch Remote Console” (or Download Remote Console if you have not already installed the application).
  When you select this option, a new VMware Remote Console window appears. Additionally, a new blank tab is created in your web browser. This tab is not used and can be closed at any time.

- **Web Console** — This option is available by right-clicking the VM and selecting “Open Console” in the menu.
  When you select this option, a new tab is created in your web browser that contains a remote session to the VM.
Configuring the Virtual Machine BIOS

During the virtual machine configuration, you instructed the VM to enter the system BIOS on first boot. In this section you configure the virtual BIOS for use with Media Composer.

To configure the virtual BIOS:

1. Use your mouse to click inside the VM display window to switch keyboard control to the VM.

To release the keyboard and mouse from the console window, simultaneously press the Ctrl and Alt keys (briefly) on a Windows keyboard.

2. Set the System Time and System Date through the BIOS. The keyboard’s tab key is used to switch between the hour, minute, second and month, day, year.

3. Set the virtual floppy drive “Legacy Diskette A” to Disabled. Even though the device has been removed in the virtual hardware, it also needs to be disabled through the VM BIOS. Use the space bar to cycle through the options until the floppy is listed as Disabled.

   "Legacy Diskette B" should already be disabled. If it is not, disable the device.

4. Use the arrow keys to navigate to the Boot menu.

5. Use the plus and minus buttons on the keyboard to adjust the boot order to the following:
   - Hard Drive
   - CD-ROM Drive
   - Removable Devices
   - Network boot

6. When done altering the BIOS settings, press F10 to “Save and Exit.”

7. Select Yes when prompted to “Save configuration changes and exit now?”
   The system reboots and the Microsoft Windows setup screen is presented.
Installing Windows Operating System

Now that the operating system is available to the VM, the Windows 10 image can easily be deployed to the virtual machine. This process guides you through the installation and initial configuration process.

As a reminder, the keyboard and mouse can be released from the console window at any time by simultaneously pressing the Ctrl and Alt keys (briefly) on a Windows keyboard.

To install the operating system:

1. In the Windows Setup, use the menus to select a value for the following options:
   - Language to install
   - Time and currency format
   - Keyboard or input method
2. Click Next to proceed to the next window.
3. Click the Install Now button and follow the prompts to install Microsoft Windows 10.

During the installation, the wizard prompts you to connect to a network. When this option appears, select “Skip for now”. Since Windows 10 does not natively support the VMXNET 3 network adapter, you will not have an option to configure networking at this time.

4. After the Windows installation is complete and you have accessed the Windows desktop for the first time, shut down the guest operating system using the standard Windows shut down process.
5. In the vSphere Web Client, right-click on the virtual machine in the Hosts and Clusters pane and select Edit Settings.
6. Click the arrow to the left of the “CD/DVD Drive 1” menu to reveal additional options.
a. Deselect the “Connected” check box in the CD/DVD drive options. This disassociates the Windows ISO from the VM’s optical drive.

b. Change the first pull-down menu from “Datastore ISO File” to “Client Device”.

c. Click the OK button at the bottom of the window to save the changes.


8. Proceed to “Installing VMware Tools” on page 35 to install the driver for the VMXNET 3 network adapter.

---

**Installing VMware Tools**

VMware Tools add functionality to your virtual machine such as the ability to seamlessly move the mouse between the VM console and your desktop. Additionally, VMware Tools enables the use of the VMXNET 3 network adapter which is required for all Media Composer VMs.

**To install VMware Tools on a new virtual machine:**

1. Open a web browser and log into the vSphere Web Client.
   The web client can be accessed by navigating to: https://<vSphere server IP address or hostname>/vsphere-client.

2. Select the “Hosts and Clusters” option on the left side of the interface.

3. Right-click on your new virtual machine in the Hosts and Clusters pane and select Guest OS > Install VMware Tools.

4. Click Mount in the Install VMware Tools window to mount the VMware Tools disk image to the virtual optical drive on the Windows VM.
   As shown in the following illustration, the Recent Tasks pane at the bottom of the vSphere Web client indicates the status of the task.

   ![Recent Tasks](image)

   The VMware Tools image is mounted to the VM’s optical drive.

5. In the Windows VM, double-click on the optical drive to access the image.
   If you are prompted with a User Account Control window asking if you want to allow the VMware installer to make changes to your device, click Yes.
   After a few moments, the VMware Tools Setup window appears.

6. Click Next at the Welcome window.

7. Select the Typical install option and click Next.
8. Click the Install button in the following window and click Finish when the installation is complete.

As the VMXNET 3 driver is installed, Windows might display a message asking if you want to allow your PC to be discoverable by other systems on the network.

![Image of a dialog box asking to allow your PC to be discovered]

If this message appears, click No.

9. The end of the VMware Tools installation process requires a restart of the machine. Click the Yes button in the final setup window to complete the installation.

10. After the reboot, sign in to Windows and verify that the VMXNET 3 driver is installed.
   a. Right-click on the Windows Start Menu icon in the bottom-left corner of the task bar.
   b. Select Device Manager from the list of options.
   c. Expand the Network adapters category and verify that the vmxnet3 adapter is present.
   d. After you have verified that the adapter exists, you can close Device Manager.

A successful installation also results in a new VMware icon in the Windows System Tray.

11. Continue to configure Windows by following standard processes for assigning a hostname, IP address, and other system settings and configuration options.
Installing and Configuring the PCoIP Agent

Each of the zero client devices used to test virtualized Media Composer systems implement the PCoIP protocol which assists in processing images and sound between the device and the VM. Before connecting to the VM from the zero client, you must install a PCoIP agent on the virtual machine to enable the connection.

At the time of this document’s publication, the following links provide instructions for installing the connection agents (these links could expire or change without notice):

- Teradici Cloud Access Software (PCoIP Graphics Agent)
  
  http://www.teradici.com/web-help/PCoIP_WS_Access_SW_UG_HTML5/03a_Install_TWAS_GA.htm

  Teradici has both a Standard agent and a Graphics agent available. You must make sure to download and install the Graphics agent on the Media Composer virtual machine.

- VMware Horizon Agent for Windows
  

The Teradici Cloud and VMware Horizon solutions provide similar functionality and do not often co-exist in a single facility. If for some reason both solutions are present, you must only load one of the software clients on a single VM. Installing both applications on the same VM is not supported and can lead to the inability to connect to the VM or other performance-related issues.

After the connection agent has been installed, you must configure the agent’s settings for use with Media Composer. Proceed to one of the following sections:

- Configuring the Teradici Agent
- Configuring the Horizon Agent

Configuring the Teradici Agent

Complete the following process to configure the Local Group Policy for the Teradici agent.

To configure the connection agent:

1. Click the Windows icon in the bottom-left corner of the screen and type: run
2. Select the Run (Desktop app) from the menu.
3. Type the following into the Run window and press Enter:
   
   gpedit.msc

4. Right click on the Administrative Templates folder under Computer Configuration and select Add/Remove Templates...
5. Click the Add button.
6. Navigate to C:\Program Files (x86)\Teradici\PCoIP Agent\configuration, select the Teradici template named “pcouip.adm”, and click Open.
7. Click the Close button to exit the Add/Remove Templates window.
8. Click the arrows to the left of each menu tree option to navigate to: Computer Configuration > Administrative Templates > Classic Administrative Templates (ADM) > PCoIP Session Variables > Overridable Administrator Defaults

9. In the pane on the right, double-click the setting to “Configure PCoIP image quality levels”.

10. Select the Enabled button near the top of the window and configure the Maximum Frame Rate to a value of 60.

11. Click Apply and OK.

12. In the pane on the right, double-click the setting to “Configure the PCoIP session bandwidth floor”.

13. Select the Enabled button near the top of the window and configure the session bandwidth floor to a value of 100000 kilobits per second.

14. Click Apply and OK.

15. Close the Local Group Policy Editor.

Configuring the Horizon Agent

Complete the following process to configure the Local Group Policy for the Horizon agent.

**To configure the connection agent:**

1. After installing the Horizon agent, you must download an additional package from VMware to be able to alter the Windows Group Policy.
   
   a. Open a web browser on either the Media Composer VM or another machine that has internet access and navigate to: https://my.vmware.com

   b. Enter your VMware user credentials to log in to the site.

   c. Go to the Product Downloads page and download “VMware-Horizon-Extras-Bundle-<version>.zip” under a section titled Horizon <version> GPO Bundle.

2. If you did not download the file directly to the Media Composer virtual machine, copy the file to a temporary location on the Media Composer VM.

3. Unzip it to reveal the contents.

   As the file might contain multiple lose files, Avid recommends extracting the file to its own folder.

4. Click the Windows icon in the bottom-left corner of the screen and type: run

5. Select the Run (Desktop app) from the menu.

6. Type the following into the Run window and press Enter:

   `gpedit.msc`

7. Right click on the Administrative Templates folder under Computer Configuration and select Add/Remove Templates...

8. Click the Add button.

9. Navigate to the directory where you unzipped the Horizon package, select the “pcoip.adm” template, and click Open.

10. Click the Close button to exit the Add/Remove Templates window.
Adding a vGPU to the Virtual Machine

11. Click the arrows to the left of each menu tree option to navigate to: Computer Configuration > Administrative Templates > Classic Administrative Templates (ADM) > PCoIP Session Variables > Overridable Administrator Defaults

12. In the pane on the right, double-click the setting to “Configure PCoIP image quality levels”.

13. Select the Enabled button near the top of the window and configure the Maximum Frame Rate to a value of 60.

14. Click Apply and OK.

15. In the pane on the right, double-click the setting to “Configure the PCoIP session bandwidth floor”.

16. Select the Enabled button near the top of the window and configure the session bandwidth floor to a value of 100000 kilobits per second.

17. Click Apply and OK.

18. Close the Local Group Policy Editor.

Adding a vGPU to the Virtual Machine

After you have installed and configured Microsoft Windows on your virtual machine, you must add the NVIDIA vGPU (virtual graphics processing unit) resource to the virtual machine and install the supporting software.

After you install the NVIDIA driver, you will no longer be able to access the VM through the VMware Remote Console. While the zero client is required to operate Media Composer, a system administrator can connect to the VM through alternative solutions to complete tasks such as configuring the operating system or installing applications such as the Media Composer software itself. The following systems are available to complete these administrative tasks:

- Teradici Cloud Access Software
  Available as a standalone client application, this software can be installed on a Windows or Mac workstation to enable a connection to any machine running the Teradici agent.

- VMware Horizon
  Sites that have purchased this option can use the Horizon Software Client to further configure the Media Composer virtual machine.

- Remote Desktop Protocol
  RDP applications such as the Remote Desktop Connection software that ships with Microsoft Windows can also be used to connect to the VM.

⚠️ When operating any Avid applications on the virtual machine such as Avid Media Composer, you must connect to the VM using the zero client device. ⚠️

In this section, you must complete the following three tasks:

- Reconfiguring the Virtual Machine Settings
- Installing the NVIDIA Driver
- Licensing and Configure the NVIDIA GRID vGPU
Reconfiguring the Virtual Machine Settings

To add the graphics adapter:

1. Assuming that the VM is powered on, shut down the guest operating system using the standard Windows shut down process.

2. Once the VM is completely powered-off, right-click on your virtual machine in the Hosts and Clusters pane and select Edit Settings.

3. Click the New Device menu at the bottom of the screen and select the Shared PCI Device option.

4. Click the Add button.

A “New PCI device” line is added to the list of VM settings.

If you see a Warning message regarding the memory reservation setting, it means that you most likely did not select the appropriate options when configuring the Memory for the VM. You can click the Reserve all memory” button to update the settings.

5. Select the grid_m60-4q option from the GPU profile menu.

6. Click OK to add the graphics adapter to the VM.

Installing the NVIDIA Driver

This process installs the graphics driver on the VM. Prior to initiating this process, download the software for the graphics adapter from NVIDIA website.

The file name of the driver package should be similar to: <version>-grid-win10-server2016-64bit-international-whql.exe. When downloading the driver package, make sure that you obtain the grid driver and not the tesla driver. Avid requires a minimum driver version of 369.71. Contact NVIDIA for updated information on supported NVIDIA drivers in a VMware environment.

For more information on downloading the NVIDIA driver software, see “Installing the Graphics Card Software” on page 12.
To install the NVIDIA supporting software:

2. Double-click on the installer package to begin the installation process.
   If you did not download the installer directly to the Windows VM, you must first copy the installer package to a temporary location on the VM.
3. When prompted with the Installations options window, select the Custom (Advanced) option and click Next.
4. In the Custom installation options window, verify that all installation options are selected and that the box to perform a clean installation is also selected.

   ![Custom installation options]

   Click Next.
5. Once the installation is complete, click the Restart Now button in the NVIDIA window to reboot the Windows operating system on the VM.
   You must always reboot the VM after installing the NVIDIA software, even if you are not prompted to do so.
6. Close the Remote Console window or tab.
   After you install the NVIDIA driver, the Remote Console window will turn black and you are no longer able to use it to connect to the VM.
7. Log back into Windows using a zero client device or one of the connection methods described in “Adding a vGPU to the Virtual Machine” on page 39.
8. Right-click on the desktop to verify that the NVIDIA driver has been installed.
   As shown in the following illustration, a new “nView Desktop Manager” appears in the menu:
Licensing and Configure the NVIDIA GRID vGPU

After installing the NVIDIA driver software, you must license the vGPU with the NVIDIA license server. For more information on this process, search the NVIDIA Knowledge Base for the NVIDIA GRID™ ENTERPRISE SOFTWARE Quick Start Guide at:

http://nvidia.custhelp.com/app/home/

To license the vGPU:
1. Right-click on the desktop and select “nView Desktop Manager” from the menu.
2. Select Manage License from the Licensing option in the “Select a Task” pane on the left.
3. Enter the fully qualified domain name (FQDN) of your license server and the port number at which the server can be contacted.
4. Click Apply.

To configure the NVIDIA card settings:
1. Right-click on the desktop and select “nView Desktop Manager” from the menu.
2. Click Manage 3D Settings.
3. Click the Global Setting tab.
4. Under Global presets, select Base Profile.
5. Scroll to locate the Power Management Mode. Select Prefer maximum performance.
6. Click Apply.

Installing Media Composer

The final step in the VM configuration process is to install Avid Media Composer on the virtual machine. The following section only contains steps that are specifically related to the installation of Media Composer on a virtual machine.

To install Media Composer:
1. Download or copy the Media Composer software to the Windows VM and follow the steps in the Installation Guide for Avid® Editing Applications to install and activate the editing software.


   The ability to run Media Composer as a virtual machine requires a new purchasable license option. When activating the Media Composer software, make sure that you also activate the virtual machine option.

   If you have not yet purchased the virtual Media Composer software, contact the Avid Sales department for assistance at: 1-800-949-AVID (2843).

2. Install any additional applications as required by the Media Composer documentation (such as QuickTime Player) or as required for your workflow (such as Avid NEXIS client or Interplay Production components).

   The Avid Media Composer ReadMe instructs users to install the NVIDIA driver that comes with the Media Composer software package. As you have already installed the graphics driver for the NVIDIA Tesla M60 card, do not install the driver included with Media Composer.
3. After Media Composer is installed and activated, you must verify that the Render settings are configured correctly to for use with the vGPU.
   a. Launch Media Composer and create a new project.
   b. Select the Settings tab from the main project window.
   c. Open the Render settings and verify that the option to “Disable GPU effects” is selected.
   d. Click OK to save the settings.

4. As noted in the “Limitations and Notes for the Zero Client Device:” on page 18, audio playback through a zero client might result in an A/V sync delay of up to 100ms. If you determine that your audio and video are out of sync, you can open the Media Composer Desktop Play Delay setting and adjust the option for “Video Sync Delay For Remote Client Milliseconds”.

   ![](image)

   The actual delay can depend on a number of factors. When adjusting this setting, Avid suggests that you start with 100 milliseconds and adjust the value as needed.

   *For more information, see “Adjusting the Play Delay Offset” in the Avid Media Composer Editing Guide.*

---

**Adding Avid Artist DNx I/O to the VM**

When you install Media Composer, drivers for the Artist series hardware are added to the operating system. If you completed the process for “Connecting to an Avid Artist | DNxIO or Avid Artist | DNxIQ” on page 13, you can now add the hardware to the Media Composer virtual machine.

After you assign the device to a VM, the Avid Artist DNx device cannot be assigned to another VM. If you need to reassign the hardware to a different VM, you must edit the settings of the first virtual machine and remove the device before you can assign it to another VM.

*Leostream Connection Broker v8.2 does not support PCI-E device pass-through. This means that Avid DNx I/O devices cannot be added to Media Composer virtual machines using this version of Leostream software.*

**To add a DNx device to the virtual machine:**

1. Assuming that the VM is powered on, shut down the guest operating system using the standard Windows shut down process.
2. Once the VM is completely powered-off, right-click on your virtual machine in the Hosts and Clusters pane and select Edit Settings.
3. Click the New Device menu at the bottom of the screen and select the **PCI Device** option.

4. Click the Add button. A “New PCI device” line is added to the list of VM settings.

5. Select the Blackmagic Design option from the New PCI device profile menu.

6. Click OK to add the device to the VM.

7. Start the Media Composer virtual machine.

8. When you are connected to an Avid DNx IO or Avid DNx IQ, you might need to adjust the “Video Sync Delay For Remote Client Milliseconds” option in the Media Composer Desktop Play Delay settings. The default value of this setting is configured for zero milliseconds, which is the correct value when you are connected to the DNx hardware.

   On your next launch of the Media Composer software, open the Media Composer settings and verify the configuration of the Desktop Play Delay setting.

---

*The HDMI video on the client monitor can be 2-3 frames behind the video on the desktop display. This is a standard HDMI delay and is not related to the VM environment. The SDI output of the Avid DNx hardware is aligned with the desktop display (no delay).*